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Paper Set 1 - 22 May 2026 - 4:00 PM - 5:30 PM - OSSSC CRE 2025 (Odia)

Q1 Quant
QG AM@RE X2 - 7x + 12 = 0 Q IR a G B @4, 696@ (a + B)A(a? + B?)
QAN 6R6G?

A. 1,125
B. 1,175
C. 1,225

D. 1,275

Q2 Quant

AR @681 @4@ 30 M/s 6@616Q IR RREE 9@° Ix km Q@I ASFE
@RQIg 40.25 FIRe aflg BB, 696@ X @ MY FE /R |

A. 10.05
B. 8.05
C. 9.25

D. 7.75

Q3 Quant

R QYI6l6Q 7:8:5 AQUIe6R T20, T10 B 35 (@l 2], AIQIQ ARS8
¥4,900 2i6%' | @4IG16Q T5 ()@l 606916 AG?

A. 60

Q4 Quant

661IGN QIR 20 FRGER 66IGN G1R] 94 KRR | CIRR OR QUGER
RS 62I6] O1GF 94 @GQ! Alal 25 TR AR RGN | A8 ¢1& Q4
2N, 626@ M@ QIR C1& Gl 62Q1 AN 696Q A MIGQ?

A. 50 f@g
B. 60 &G
C. 80 6i@g

D. 100 fife

u Blackbook Vocabulary — Now in the App

Q5 Quant

@66 QIR GIR@ 150 km @Q@IQ 50 km/h 6@6I6Q 2GR KRG 9&° 30
km/hr 66I6Q 6rQ2lIE | AFG IR RN PIFR LIQULIR 6@6! (km/hr 6Q)
6R60?

A. 375
B. 40

C. 425

Q6 Quant
IR 6QFREQERQ T52,500 6 5@ KAUARE | 22% B 12% @ @Fe
Q216 A6Q MY FE AR |

A. ¥38,036
B. ¥36,036
C. 736,336

D. ¥38,636

Q7 Quant
4-2F DEIQ Q°GMI 2x41 6QAX Q flmY 6@6Q 62, MILI QI QGHIS 3 QI
AR 621 9Q° X 2 Ol @@ 9@ 661D Q°6i4l 21667

A 3
B. 5

Q8 Quant

38 @61 @Q A, BB C @ Q99Q QIS 3:5:7 266 | Y@ QYQAIN6R B QI
AR 20% PG RQE 9e° C QIx AFAR 10% @R66 KR8, 60§
698 2°6l 2R 6AFNRT ARA6RQ RID | A QIR AFA6Q T15,000 F16IG | 9D
ARRER A6R A B B KQ 989 2gale 9:10 94| A G C @1 2361 a8
ARIY6R AR 6R6G?

A. ¥52,500
B. ¥60,000
C. 367,500

D. 72,000
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Q9 Quant

G 6616\ P2Y6QGR AIRIYEI 4x IQ° SIRFR 3x (6DRQVIER x>0) @9,
606@ P2I6QATR FIRMAIR 6R6G?

A. 4.5x
B. 2.5x
C. 1.5x

D. 4x

Q10 Quant

R 30 MO F151616Q J1Q 9e° AIER QAR 3:2 266 | 9@ 2Qale 1:1
@8R AR F5616Q TSI 2jel AIEIQ QRIS (RER6R) RIS @ |

A 6

B. 2

Q11 Quant

@66 1R OIF OFIQ 20% PAURAIE | FIUER 62 ARER FFIQ 25% 6l
@B | 9% QI AGIER T525 UREIQ, 2N, 66@ AR QNS 6@6@ SJmI?

A. 3875
B. ¥700
C. ¥750

D. 825

Q12 Quant

@661 6QIRIRT IR QAR RS ARIY YR § FIRIOIQ 35% i@ I
@8 | 8% RIR AR AR ML ANY RUER 606S JPEIe QRIG 6alg
AGe?

A. 20%
B. 18%
C. 17%

D. 19%

Q13 Quant

IR FERER 66116 BUIel et 66115\ @T6R 20% 9F AIRER 2IGY
66157 @F6Q 20% 219 AN | 9@ 2017 AR 98 AGear @6 2AREY
62IRYM, 626@ 2017 T2l @RAIER 2021 ATRIER IR @G4Ieh Qo6
6QARYMI |

A. 7.84% @&
B. 7.84% @Ig
C. 8.78% @&

D. 8.78% @I

Q14 Quant

6a161d 9@ QIJIG A 606% AAUER RS, B @ C FRe @l6e 626
AFN6R 698 RITIEG AR @QF | A @ B Fid 698 @146 3 Br6R
Qerd @ARIEeER C IR 692 QIITY 6 Gr6ex Aty RRAIRE | 6069 B
QIR 628 QIHIEg 6960 SR6R Al KRAIRER?

A 12
B. 14
C. 16

D. 18

Q15 Quant

Q™R 3% 0Fe® QI ARER 2 @d A6Q AIY AR 2,00,000 G|
626, SR6AG FAUTNRLR| ARIA (T6Q) 6@66? (@6IFR QR YIe Ais)

A. 188509.17
B. 188519.18
C. 188512.23

D. 188526.11
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Q16 Quant
Q@ a B QRN AAQAIB b @9, 666@ A8 QAR 266 |

A a:c
B. ¢:a
c. ¢:b
D. b:e

Q17 Quant
IR FRRR QPAINGR AQAIS 6 : 9 : 10 9Q° ARQIAN 250 cm 626, IR QLAF AP J& AR AR 6644 Fda @x |

(Use /455 =21.3)

A. 4456 cm
B. 49.78 cm
C. 53.25cm

D. 57.18 cm

Q18 Quant
66l | || m 9e° 9@ 620 t 69N 68Q @RI | 9S21 = 65° @9, 22 @@Q @ |

=

A 115° a2
B. 650

c. 105°

p. 00°

Q19 Quant
ABCD 9@ 69@@ | ABC 4e° ACD Q@6 2RI 8@, JI2IQ 96047 QIZR 68dY 4 YRR | FPERTR REQUR 686 FIYER 2@l 28R (YRRE6R) 6R6G?

~2(y2-1)
5. 4(y/2 =1)
¢ 4(y/3-1)
0. 2(y3 -1)

Q20 Quant
A @

\/ﬁ?[l +\/'3 + 278 + 114 + 30
A. 25

B. 26

C. 21

D. 27
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Q26 GA

Q21GA
AIRGE AR RIQIQ AR 2025 6Q QANPR 52@¢1 (81 FRIQAE QUIER
YD FQUARYRI?

A.

g @l
gdixie

Q. 2 AR

. @602 AR Al6RERN1

Q22 GA
@@ 2025 6Q 6 ARI6IQ QVUFE ReQ! AN PN ARIQ 696 QAR
'QEQUIG QIR 6ARR RN, @RWI?

A.

QAAYERE!
agle
Agcaer

IEN (SR

Q23 GA

515 f6'Q @@l @8I FlQE, Gals@ismI (Mount Diavolo) 21&liele
QUYBR 69Q QGIER AQTE?

A.

Q@R 2R
A 1SN
@& 2lgiele

MO 28R

Q24 GA
1916 62I¢1 QR Me| 2I6LIRE (Home Rule League Movement) 6@&
6RQIF 6QQQER 6LARSMmI?

A.

QR GFFRIR BR@ 9e° 2B 6998
6611 9 66lII6M 9G° DR
QAR RIERART IQ° 2IH 68

AIe]l Gl Q@° @RQILAMIM 606QQ

Q25 GA

6GIECInD 6FERY QAR BRGIQ 6R6RIT RS QUIAR AIRER QD
FRAAREG?

A.

QIR

Qg

)}
)

u Blackbook Vocabulary — Now in the App!

2025 €II@ FI96Q AeFIE QIR YRIERR AIO1S 2A@ AP HoY
@I@@! (Intangible Cultural Heritage) 6Q B26IQ GOMGE 6a6o'g AIFIM
RRAAIRMI?

A.

26 9@
QIR AR
@EPE SR

cllal 9gen

Q27 GA
14 061 AIPR SRR AARAT (AFTS) PRI 629G AR 66! QA
26De 6QARYMmI?

A.

C.

D.

e@al
QBT
RRERR2I

[alial]

Q28 GA
QUG AARIR 686 @F '6QI6RF SINGIA (G IRF) Q AR, FReER?

A.

1973
1983
1993

2003

Q29 GA
QAR /AR ORIOR 6JPR ARG AR BRI ARRIR U6FIRR 2025 6
6% 6AIRRIQ AN JeIe @588?

A.

fee aels GRS
8Q ARIAE 626'EIE Jel
AROE 2 FHIERREAE, 2P ZIRITR 26AQ 8 6ReEIe

(B4l QRGAIM RERFTRT 691Gl

Q30 GA

QIR @RI IG° YEIIRR 6l 2ARIR AUNER @RS ALY, JYIIRMI,
R, AANGRR” Gl 9e° QUSRS @U6R AIGTE 5T AR BFEIR
6@C 6R0IF QIR FRINF FRTNRRI?

A.

Q@ JeRIAe
PR ALRIAR
RIYER @I

H. K. fleele
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Q31 GA

69QIM RERIEQAR R6ElY (Global Innovation Index) 2025 2g@Qli
FINGIE AR VNS BEYIR6R 694 YR AR FRR?

A. 380¢
B. 45 ol
C. 2504

D. 81 ed

Q32 GA

FIRGE FRINQ 606 ARG ARRIQT '6el6ml Q82 CARRIR IR TS
QERENG A6SIRF AR RER| RER?

A. 2RCIOIN QL 2AAQYIY FIPIRRAIRG YOF QU6 600
dle Q@ |

B. JOQ@IQI? 66IRIRFING 596 @5 96° 6QFIRG die Q1URIRIR
Q191 AR5 ARAG| IR KR, YEAR N6 F1PIQ FRIEIQ 6QVDS
a9l |

C. 3606 goifE ISR AIIYFIEQR 2RFR §10! AR 99Q 62Ral
600m IME 2I2ERE FIRG 22~ @ 2A9QIR JOIR @Rl |

D. Q6N F1Q1 IRI6VFIYPR FAGE RQQ| 98° BRG QURY FIIYER
9@ QAR 6RIE° AIRRE] MG @R Al |

Q33 GA

UD ARR2R YR AR 6R60R AR | 26 Y ILHIRAIER SR
@, 606@ @8l AGQ?

A. 6QI9@ QR AR 627 692 GG R RRAINES FIR™
B. 69@ 2°6Ig|0a6R 2I6RIS A6 V8 G 2IQF) 6Q1RQ
C. 69@ 2r6lgPe 2R ARCNEIR AYRIP QYR RS

D. 692 2°61geR ARN6ER @B AR

Q34 GA

Q-0 @l (Mass movement processes) 6Q &iml G AIFQ ReIF)6 61
AR 6RR @R AUV QURER QKA1 2667

A deq
B. ARMSIS
C. @@

D. @id

Q35 GA
A% IR Q@M 6MYR 6FIRY @QG! 25 cm @I e° @gdg 6@ Ol 50 cm
QR ABIDIN, 666@ G 6@R0I6R I8, 62a7?

A. QAIe AiEeR 6RG OIQ 75 cM QR6ER
B. G010 digeq 6mg OIQ 25 cm 9a6a
C. QAR A6 6mY OIQ 25 cM QAER

D. 3a1e AIE6a 6mE OIQ 50 cm QR6R

Q36 GA
D 616 2HRR MeP 2AQAIS 950 @, 606 @ IR 2Ue] @817

A. 9@ 1000 @8 Q@S A8l 950 R AR 288
B. 6716 @AQCaiil 950 266
C. QABQGI 2R 950 266

D. 9& 1000 @& (1@RIa T8l 950 @8 9 288

Q37 GA

ARG QNP VRMIRANAEF FRIIQ 69 1@ Q@GP AUVER RURGR
@1 PG 6MGRI AR AP RENGEI 2ASE?

A. €99 69A9IQ
B. Q@192 ¢166IQ
C. QefEl QIae1

D. 20Q°6 QU QPR

Q38 GA

QARIY AR 694 AQYST 622 B AURIGYER FRINERQ VG @8R
A6 @ERI @REIN?

A. Q26 2g9e1
B. QQF 29901
C. Aef 2gge1

D. Q&¢ 2A9Ye1

Q39 GA

ARINEIPE 62X IR AR KM 60R MIPY 695 Eie D8R
QA0 RAVRAIQR?

A. QR
B. @q
C. dee

D. @l

Q40 GA
2012 6@ 6010 66 QIR QIRQIG! ARRE AR FIMYE 6R6 REVT
G0 6QIRemI?

A. IR @86
B. 6@M@Q @G
C. QFFRIRR RFE

D. LM &°@e1«fd
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Q41 English
Complete the sentence with the appropriate adjective.

Her performance was ____ and left the audience speechless.
A. astonish
B. astonishing
C. astonished

D. astonishment

Q42 English
In the following question, choose the appropriate option which completes the sentence. If the
sentence is correct, choose ‘No article required'.

evidence you want is difficult to locate.

A. A

B. An

C. The

D. No article required

Q43 English
Select the option that can be used as a substitute for the underlined group of words.

During the memorial service, Jasmine delivered a heartfelt speech honoring_and praising_her grandmother's life and legacy.

A. alampoon
B. anelegy

C. adedication

D. aeulogy

Q44 English
Which sentence is NOT in passive voice?

A. The project was completed on time.

B. The medicine is taken twice a day.

n

The gardener watered the plants.

D. The wall was painted red by the artist.

Q45 English
A word or phrase that reads the same backward as forward, such as 'madam,' is called a/an

A. anagram
B. palindrome
C. homonym

D. acronym
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Q46 English
For the sentence below, identify the option that is the correct antonym of the underlined word in the sentence.

Her behaviour was so erratic that the teacher struggled to predict how she would act next.

A. unpredictable
B. irregular

C. consistent

D. volatile

Q47 English
For the sentence below, identify the option that is the correct antonym of the underlined word in the sentence.

The scholar published a work of superficial analysis which ignored the deeper issues.
A. shallow

B. cosmetic

in-depth

(g

D. cursory

Q48 English
Select the option that correctly substitutes the underlined segment so that the sentence remains meaningful.

When she heard the disappointing news, she simply put off dealing with it until things looked more favourable.

A. called it a day
B. took it with a grain of salt
C. threw caution to the wind

D. kicked the can down the road

Q49 English
Choose the incorrect sentence in direct speech.

A. She said, "I like coffee.”
B. He asked, “Where do you live?”
C. They said, that “We are ready.”

D. Johnsaid, “Let's begin.”

Q50 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

P= That are widely known for their extremely fiery flavour
Q= This state is the largest producer of Guntur red chillies
R= That they impart to the dishes

S= And deep red colour

A. QPSR
B. SRQP
C. SPQR

D. PSRQ
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Q51 English
Select the correct proverb to replace the underlined segment.

The coach reminded the players that practice leads to improvement.

A. look before you leap
B. no pain no gain
C. practice makes perfect

D. all that glitters is not gold

Q52 English

Read the given passage carefully and answer the questions that follow.
The Mesopotamian civilisation, often called the “cradle of civilisation,” developed between the Tigris and Euphrates rivers. It is known for several
important achievements that shaped early human society. One of its greatest contributions was the invention of writing, known as cuneiform,

which allowed people to record information, trade, and laws.

Mesopotamians also made advances in mathematics and astronomy. They developed a number system based on sixty, which is still used today
to measure time and angles. In addition, they built impressive structures such as ziggurats, which served as religious centres.

Another major achievement was the creation of one of the earliest legal codes, known as the Code of Hammurabi. This helped establish rules
and maintain order in society. The civilisation also improved irrigation techniques, allowing farming to flourish in a dry region.

These achievements show that Mesopotamia played a crucial role in the development of organised society and human progress.

What was the primary purpose of ziggurats?
A. Centres of political administration
B. Facilities for commercial exchange
C. Structures for religious activities

D. Storage units for agricultural goods

Q53 English
Where was the Mesopotamian civilisation located?

A. Across elevated mountainous zones
B. Across scattered island groups
C. Between two major river systems

D. Within vast desert landscapes

Q54 English
Select the most appropriate title for the passage.

A. Ancient Advances in Science and Religious Practices
B. The Achievements of the Mesopotamian Civilisation
C. Evolution of Political Institutions in Ancient Mesopotamia

D. Social Structure and Innovations in Early Human History
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Q55 English
Select the most appropriate antonym of “flourish.”

A.

Prosper
Succeed

Decline

Expand

Q56 English
What does the passage suggest about Mesopotamian mathematical knowledge?

A.

It was limited to basic numerical counting.
It lacked application beyond agriculture.
It influenced systems still in use today.

It remained confined to local calculations.

Q57 English

In the given question, a statement divided into different segments is given. The first segment is fixed, rearrange the other segments to form a
coherent statement.

What tokens of excellence / clamors for your attention (P) / get back to your priorities (Q) / can you find that will quickly help you (R) / when the
crush of daily events (S)

A.

PQSR
RSPQ
QRPS

RQSP

Q58 English
Select the option that rectifies the incorrectly spelt word in the given sentence.

The team's dedication and perseverence were praised in the final meeting.

A.

perseverance
persaverence
persevrance

presrvence
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Q59 English
Select the most appropriate option to fill in the blank.

The athlete's performance was truly , setting a new world record.

A. mediocre

B. ordinary
C. remarkable
D. unimpressive
Q60 English
Select the sentence that is in the correct form of the future tense.
A. He will starting his new job next Monday.
B. We will be travel to Paris next summer.
C. She will write a book about her travels.

D. By the time you arrived, we will have eaten dinner.

Q61 Odia
AN FRPYPR FRMNQ FUAIRIYR! BH2 QYR A0R RAUR1 2GR IS,
Qg @UGER IR AENR 26T |

A. Rain is essential for plants.
B. Rain are essential to plant.
C. The rain be important for plant.

D. Rains is necessary to the plants.

Q62 Odia
AMee FRFYee FRINQ GAIKIRR! BeE QIRIR A0R R°AURT AFASC QKL
RAER IR JRIPR SR 60 2166 |

A. Taxila was an ancient center of education.
B. Taxila were ancient education centre.
C. The Taxila is old learning centers.

D. Taxila be the ancient educations.

Q63 Odia
QMo FRFYee FRINQ GAIIRR! Be2l QIRIQ A0R R°AURT AQRIC VLY,
AERVARYER AR QG FRQGIER V& VPR LOIRR AR QUIEE FQAARE |

A. Submarines are designed to operate underwater at different depths in the oceans.
B. Submarines is designed to operate under water at different depth in oceans.
C. Submarines are design to operate underwater at different depth in ocean.

D. Submarine are designed to operates under water at different depths of oceans.
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Q64 Odia

FIMGe AP FANTYT ONAIFER IR | O P6F Y@ Y6SUR JI SIRT ARITE Q@R AR A0 @NG CAR KNS |

QU IR el IR Foeide a°gl Rl AIDIF YRIIP ARER TG JI9Q FRRIR I FRed QIEe GaIdIRaRI 921 1946 FJLIER RUIF6Re F6ie
6d1RRIQ ARG AN 610 62RMI, AL QIR ANER MG ARG AANDE KA IR IR S1I0R FAVRAIRR| PLQR PRI I I
2RNIVEIER URARIR FEIFl 6809 9 AR 1946 6Q 2QFE 6QRAMI, ILAER PFR AUCRL YARF I 2R (ARUF) QPR FAIFE FRATIRSRII
RUPARUER YINALER 389 AR 2J6M, 6TRUER Y6@E Ie° GIPRIC ARIGPRR JGFY 2SR 2J6m, @3 1947 FTRI6Q FRURR U6Q, AQQY QA°6HHI 299 @
QA AIRYRII

ARG AR FEG RFE FIMYFER I FRER, 6CGIER QI REIF AQOIQ FRRUE QFiR! 28l RGLRI N8 AFTQ 2HTC! @9 &. Q. 2IERR
RRYER, AIIF YA8 ARSI TR FJ6l Y6601 AUPER F6@eR! FRUTN | 2 @, 11 FlIA 98° 18 @ FRIY6Q YD TR AQIR 11 § 2RJEREIR @TejR
9G° 9@ ZRIEQEIR 6@ SIAR, 2RIRIR NG JEINAR Y6RUR B6l QUER FRIR-GFIS FAIRIYRI | AFUAR PRI QI 26 PE@ER 1949 6Q G21C 62IRR
\9@° 2l 26 IR 1950 6@ RITRIN 6RIRYR, I8 F0q JOd 616108 @Y QIRER ARE FRAUARE |

ARG AR BFE AR @R, 2ICFRRIR IR BR, SIAMIE @ ARY F1OR Fe@EIFR TRIQ Ye° FIRITLR A°AIY GI0R VARG U6PR QIR 6IRS!I
ARYRI VIR RV R 9@ AR Y& Q| AL AAY QITRRF A QUILL, YRIPS, AFIRG] IS° QAREIR YRS KA | Y2 ERIER! 9° 3o
QERCIND QRERIE YQ° ARG ARG AFCIREG 62RYM, AL FITR CIEIPIFR 2IF)Y YEFRE PRLINI IRR KT 62eR AR ARER R YA
FAREWI @Q° IR ARIQE AFRIFS QI 2RIPEQ IR §a AAIR @AR IREE RN PIRIR IR RAILRE FIIY IR @RI 69§ RN AFIR 9@
GRS ANR QR PEIAAIR 62IRE, IR YRIIAS! AR A6 Ye° ILIQ Y66IPIF AARS HIRY (@~ (8 aRelN|

QAR ARG AR 68 6ARRIER 106 6RARYMI?
A. FIQERYIEER 6QRR
B. @U96a¢ F161@ 6QRR!
C. @qdee

D. ARAR @E6e

Q65 Odia
ARG AR 24D @9 2Jem?

A. RRIPARIN 6R6RR
B. 992 Ql6@Q 9@
C. 9RQ 8. Q. AR

D. dGIQ A6

Q66 Odia
QI TR 214D @9 gem?

A. 6@.9¢. 64
B. 2RS QYN AR
C. P99Q. Q. 26PN

D. 9. Q. gela

Q67 Odia
QRGN ANIIR 6R6@ G216 62IRYRI?

A. 1521618, 1947
B. 26 R6@€Q 1949
C. 26 @92l 1950

D. 9 5649 1946
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Q68 Odia
AP ARUIQ 6REFIT YRR @T FOIR-GFI6 @5 AT UIE dYQ FAUARERI ?

A. 10
B. 11
c. 12

D. 13

Q69 Odia
ARANE! QIR F6EIVETY QAR KR |

A @@
B. @gN
C. ag

D. QeI

Q70 Odia
213 06d 20 A" - 9B 6RIERIDR 218 6ma |

A. 25 o6 aee
B. 2QR109 Qg
C. QRN FRRCI

D. 29aQ 6dI@e!

Q71 Odia
A0R QRIR 2RI QNG 596 KR |

A. 26 @RYQIEIER 2Iga R |
B. 26N 2IYALR @AIYIENER |
C. 2R @RYYIENFR 2GR |

D. 28 2gagm @e4IgIsN& |

Q72 Odia
'JRRIC FEIV YJ6m | 9B QIRYER 2Rl QR IRT 6RGE?

A. QERIQ
B. feaia
C. g6m

D. \926R 6@l6Q QR @19~

Q73 Odia
QA FRY MEEQ QA TG | AINIER 'RNTER' 60Q YRR FEEIVS! ?

A. QEIRIOR Q66!
B. QGFI6QI6% G666
C. THIRIOP BEEITE

D. QPRIRIOR F66ITE
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Q74 Odia

"ORA QR AQQ F6Q,F22E QR LR FEIR 9"- I8 6RIEFIDR OR 2el @'81 ?
A. 99 QR g5l A6Q REll A6@
B. QIQIg @09l @l @66 g6&

C. Qél 60em Q@Q 6Q6M W6

D. Q9% g6 J2fie gag @ REIae

Q75 Odia
AVGYPR 6061 6@ FREE | - 6T VT 606 IR QYA AG?

A. QAIYER 2D
B. QQFISIQe® 24

C. @Igide a4t

D. RIS ARYLL
Computer
Q76 Computer Q79 Computer
AIGIQ 8L, 2021 6@, 6@E! 64l PR 6ATEP, 6J6@EEARY P J_R6R In Windows, which of the following methods can be used to run an
SIRGI, YAPIRE QPR RU 6211 I° QERR GIR FIGAIR RS application?

@68,_IM @ Orlem @0el AR 9REe @RalN?
A. Double-click its icon on the desktop

A. 99 oo QI 69698, (M J_A) @
B. Restart the computer

B. @681 Q43 (G6dll) & QIR QAR @

o

Press Ctrl + Alt + Delete

C. 9@ QI6RUY (TR T_K) 60 QAR @
D. Remove it from the Start menu

D. 6Q6@66Q QY AR @

Q80 Computer
Q77 Computer What is the primary benefit of using a template rather than starting
REAR FIRIYFIER YRR RID GIP6FIE, AOIRS! AIG FERES FRINQ from scratch when making a presentation?

6@RGI6 A66IaF QA 2667
A. Slides cannot be deleted

A. 64N PIeMY IRRIS REFIMERQ 2R Q@R AOIB |
B. It automatically saves the presentation online

B. 2610 @I e FIRRGEq e ZIP 6CrIRase 96¢1d @8 |

C. It provides pre-designed layouts, themes, and formatting
C. AAg TIemg 6616~ Word @fY661560 @06 @08 |
D. It prevents adding new slides
D. JOIRRI OQ REFIR YPIRRIQIR SP-AF 69M 660 AR
@98 |
Q81 Computer
& AQYAIR AIGIQAE] 6T6REEARER IR @O 65FEME 2N @A
Q78 Computer QIS BIRG 696 AP6RTT A0S U667
Which of the following is a main part of the Central Processing Unit
(CPU)? A. File > New QU6Q 4@ @8@, 9@ 66'¢I6me J6my @@ 9e°
Create QU6Q 3@ @AG!
A. Monitor
B. File > Open QU6 §a @Q@! > New Template File @U6Q §&@
B. Keyboard QQQl
C. Arithmetic Logic Unit C. Insert > Template @JU6Q §@ @@ > New File 006 @QQ!
D. Printer D. Review Qd6Q @ @@l > Old Template 2G9N KA
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Q82 Computer Q86 Computer

. . Which of the following is classified as both an input and output
In context of the structure of E-Mail, match the components in 9 P P

ice?
Column A with their correct descriptions in Column B. device:
A A. Mouse
Column A - E-mail L.
Column B - Description
Component B. Webcam
a) Contains the main message content
1.To
written by the sender C. Touchscreen
2 Ce b) Sends a duplicate of the message to other D. Microphone
’ recipients for their awareness
) ¢) Provides a short summary or title
3. Subject o . t
J indicating the purpose of the email QSZCompu r _ _ _
- - — 66119 26/ said @)l 6MIERARR 2 @PIEAE, BAR @R A6R
4. Body d) Indicates the main recipient(s) to whom AIREFIAY FIF6R 696 ZARARIR 671IQ RR QI?
the email is directly addressed
A. GG 6@
A. 1-d, 2-b,3-c, 4-a
B. 60166690 G
B. 1-b, 2-d, 3-¢, 4-a
C. 6Qer6glle

C. 1-a, 2-¢, 3-d, 4-b
D. Q@-AURG 6€11@

D. 1-c, 2-d, 3-b, 4-a

Q88 Computer
Q83 Computer MS-GI6 2019 68 @@ (Ctrl + C) 9@° 6QI&, (Ctrl + V) '8l @697
IR 6696 YGeR 'agd” (Insert) 6¢106@ Y RQAS| AFER, U@ 'Ins'
(Insert) @ § 216@ QRILN, 606Q URRE AFINER FIRA FAUIRYR @O
2VRQYERR FTIRIRG FAG 6297

A. 92| 2R@FIM 6RIERIR Q 66F0Q GRS RQGN |

B. 92| 6096'q M6 @QG9
A. *de 996 gl QAQE ATVRGER RO QIER FIRT 62IRR!

2R QI BRAGESR 62 | C. 29I 6696'q 60 K6

B. ada aeed dIeg IRAE, Ye° 69068 gOR TR RAAE D. 92/ 66'g6'Q AREAIM YRER Q661 IQ° IR AT G2UR F6Q, GIUER

cRIREe | 92IQ G4 6RIERAR Bl YRER 6AT K6 |
C. da 9R6Q 9on JVRGGR RAAG 62IRDE YG° YOQ Q!
2V PR YRSRS 6QRAR | Q89 Computer
~ ~ Q90 @1QRIR @R IR G2 ARF AR *RQ! AR A0S FIREEIAR A2l
D. 66@Q IGER 'BRAARG (Overwrite)' 6719 Je 62@ 9&° oan
JRQE SR AR UVRGE] FARIRS
A. Q4> Q4 ame
Q84 Computer B. 62Ifl > @AY > RAAE T8 aRe

To copy text in Microsoft Office Professional 2021, the keyboard
shortcut to be used is:

C. QA6 > amel

D. <rim > 2d9q > 2 @mel

A. Ctrl+P
B. Ctrl+V
Q90 Computer
C. Ctrl+C @68 YRR IR @M1 (column) 6@ AAIY QUEFIRR Y&, _geae 6¢lc @ale
@R AR SIPIE | MS-96gM 2019 6Q 64 686 PFAR QLR KRR
D. Ctrl+X ~
QBR?
A. MAX
Q85 Computer
MS Y63R6Q 'RRF A" FOR RIFl @'61? B. COUNT
A. QI ONG @I C. SUM
B. ISRI® FIR6CERI 2RINER P16 A6 @AQ D. AVERAGE

C. 9% 0I6 QA6 aaal

D. &g YIRM 608 KQ!
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Reasoning

Q91 Reasoning

AFRE @P—2URIE), BRI, ORE, 6RERIRA| I° IRFI—RE Golg (@
AR IR AQREQSIER | 6QURKE | 6P6RINA I@° IQFIF FRIY6R 6QM
G008 @ 801 621088 | 2IRIE 6Q6QIRAIG O QIF AR 87| 621RT
| 0068 Y@elx OF Q216 A6 80l 6ARAT | JIGR QIFl AIFIR @1,
UR6R @9 891 6QARRE?

A. 2iRlel
B. oél

C. &ql

D. 6Q6QIRAI

Q92 Reasoning

TERRE Y QI X628 W QgIF W 628 T 821U 6208 T Q
QRIURREZRY2 1 Z62@8 Y Qg1 W 99e U §aQ @Ge?

A. Qlal
B. QAT QR
C. AT QR

D. Qldia @Idl

Q93 Reasoning

S, T, U, V, M, N 9@° O & FlINQ 6@IREQ 6Q191R1QQ IR 6@1R
QARINER 6618 62@2Q 661N YRR @G B PR ANV 2K 1 U BV
@ CRIY6Q 6RR B8 REIFR ANV AR | AYILRQ 661V @R6Q V @ A
2R 1S BT & FRINER 690R P66 IBFR AV 28 | M & OR ge &@ O
@R ANV 2R | 9910 &6 N G AV @127 I N B O & FRIY6R 6@6@
@EFQ AN 2K?

A. 9@
B. @@
c. 53

D. Q&

Q94 Reasoning

QA1 QEFIRI 9 2RISR RACE Y& 7@~ @ @alasa FOQS a8e
A¢te” @ | VEGI 628 QeIe QQIKER JSUW 986 adte ™ @ | 2aIe o
AQARE @R FAMEIC FRFYPR FRINR 6R6IE ABE LUWY a¢1e ™ ¢ 62@?

A. ZIKM
B. ZMKI
C. ZSWE

D. ZMKO

Q95 Reasoning

QG '+ 9Q° '-' @ AQYRQ FRIYEQ ARQRR KU, 9e° 'X' 9@° '+' @
AQYRQ FRIYER ARQR RAUIN, 606@ FIMSE ANRREIER I8 5% (?)
IR @'6l 62Q7

19+6+65x13-5=7?

A 114
B. 126
C. 137

D. 144

Q96 Reasoning
Jo@ 2GR PSA® QU6Q A°Y4 FHQI din ARG FRFGER FlANQ
6200g 9969 (?) YP6R YTe FRVANRANS?

TWUT WZXW ? CFDC FIGF
A. FGIH
B. ZCAZ
C. FJFE

D. FHFE

Q97 Reasoning

9@ PQ T Q 6R10 QUBIER 'pizza tip dream’ § 'wd ec st' QUPER IS°
'wave pizza gum' @ 'ec vk bf' QI6Q 6910 RAIRE | TR
RUAVER 'pizza’ @ VAR QUGS 6RIC @UTQ?

A. ec
B. wd
C. st

D. vk

Q98 Reasoning

Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statement: No Books are Magazines. All Magazines are Newspapers.
Conclusion I: Some Newspapers are Magazines.
Conclusion II: Some Books are Newspapers.
A. Only conclusion (I) follows
B. Only conclusion (II) follows
C. Neither conclusion (I) nor (II) follows

D. Both conclusions (I) and (II) follow
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Q99 Reasoning

QR QAR G 2RINER FARGE GIEQIT FINQ F6RIT IR FR ™ @
QIR A6 AGE 698 YRAR IR 66IFY1 SIOR QB | 6@ 69@
66IF1R 28LD G6E7?

(QVQY: AAFBAYT QIBERY/JRed Qo @2l AR YBER 6AFIRFR
g6 @a6Q RIS 6% 1)

A. PDSF-GPI
B. ENIR-BQFU
C. LOHX-OXKA

D. UGKO-RJHR

Q100 Reasoning

FINGE AR ARIRER YIRQ Q@R DAAB | (Y A6l 69w I 2
QEQ A°61YI U6 | FEIR 62 QIFIQ VIRIEIQ FQUIR 1)

(@€)25872697581642598625874692569 (@lwl8)

IOR 606016 29 AR 2R, 600eaa OR YO IR 29 AR 9e° OR
A6 @ e U R QRG?

A. QAQ e

B. 9@
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